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La declaracién sobre las interferencias de radiofrecuencia de la
Comision Federal de Comunicaciones (FCC) incluye el siguiente parrafo:

Este equipo ha sido probado y se ha encontrado que cumple con los limites
para aparatos digitales clase B, de acuerdo a la seccion 15 de las Reglas de
la FCC. Estos limites estdn disefiados para brindar una proteccion razonable
sobre interferencias perjudiciales en instalaciones residenciales. Este
equipo usa, genera y puede transmitir energia de radio frecuencia. Sino se
instala o usa de acuerdo alas instrucciones, puede causar interferencias
perjudiciales a las comunicaciones de radio. Sin embargo, no se garantiza
que interferencias de este tipo puedan ocurrir en determinadas
instalaciones. Si este equipo causa interferencias perjudiciales a la
recepcion de radio o television, cosa que se puede determinar prendiendo
y apagando el equipo, el usuario debe intentar reparar la interferencia
siguiendo una de las siguientes medidas:

* Reorientar o mover la antena receptora.

« Alejar el equipo del receptor.

¢ Conectar el equipo a un tomacorriente distinto a donde esta conectado
el receptor.

¢ Contactar al distribuidor 0 a un técnico experto en radioy TV.

Aviso Importante

Para cumplir con los requerimientos de conformidad de la FCC sobre las
exposiciones a las radiofrecuencias, no se permite realizar ningin cambio
ala antena o al aparato. Cualquier cambio a la antena o al aparato
puede ocasionar que el aparato exceda los limites de exposicion a las
radiofrecuencias y anula la autoridad del usuario de usar el aparato.

Recuerde que:

Los aparatos Bluetooth® de Clase 2 tienen un rango de alcance maximo de
10 metros 6 30 pies aproximadamente. Los aparatos de Clase 1 tienen un
rango de alcance maximo de 100 metros 6 300 pies. Ya que la conectividad
de los aparatos con Bluetooth® es bidireccional, el rango de alcance
madximo entre ambos aparatos depende en la clase operacional de cada
uno de ellos. Por ejemplo, cuando un aparato de Clase 1 se sincroniza

con otro de Clase 2, el rango de alcance mdximo entre ellos se limitard a
10 metros 6 30 pies. Para alcanzar un rango maximo de alcance de 100
metros, ambos aparatos tienen que ser de Clase 1.
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Uso del producto

Gracias por escoger el Adaptador USB Bluetooth® GE 99000. Este
exclusivo dispositivo permite que los usuarios puedan escuchar
musica o transferir datos entre computadoras portdtiles o de
escritorio y la mayoria de aparatos con capacidad Bluetooth®.

Modo A/V Solametne - NO necesita instalar ningtin software.
En este modo, el GE 99000 funciona como un transmisor para
transmitir musica directamente desde su computadora hacia un
receptor Bluetooth® como audifonos Bluetooth® o un receptor
Bluetooth® conectado a su equipo estéreo.

Recuerde que: NO empiece a reproducir la mdsica en su
computadora sin haber conectado primero el Adaptador USB
99000y sin que el proceso de auto-configuracion/sincronizacion
haya terminado; de lo contrario no podrd escuchar la musica.

1) Encienda la computara desde donde va a transmitir el audio.
2) ANTES de conectarlo al puerto USB de su computadora, mueva
el interruptor del GE 99000 a la posicion de A/V.



3) Conecte el GE 99000 a un puerto USB disponible en su
computadora. Su computadora empezard a instalar los
controladores de Windows® necesarios para habilitar el
Transmisor USB GE 99000.

Espere a que el proceso termine. Su computadora puede tomar
hasta 2 minutos para configurar el aparato. Durante este
tiempo, la luz indicadora azul del GE 99000 parpadeard
rdpidamente.

Encienda el receptor Bluetooth® a donde se va a transmitir el
audio. Puede ser unos audifonos estéreo Bluetooth® o cualquier
otro aparato receptor Bluetooth®.

En 2 minutos, el receptor Bluetooth® se sincronizard con el GE
99000 automdticamente. Cuando los aparatos se hayan
reconocido, la luz indicadora AZUL del GE 99000 parpadeard dos
veces y luego parpadeard lenta y continuamente una vez que los
aparatos estén sincronizados.

Abra el reproductor multimedia o de misica desde la
computadora habilitada con Bluetooth®.

Seleccione y empiece a reproducir la misica que desea escuchar.
Escuchard la musica transmitida desde su computadora A
TRAVES de la tecnologia inaldmbrica Bluetooth®. Los parlantes
de la computadora no deberdn emitir ningtin sonido.
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Nota: La primera vez que sincronice el GE 99000 con un
transmisor, puede tomar hasta dos minutos. La bisqueda serd
mds rdpida las veces sucesivas. Durante la sincronizacion, la luz
indicadora de estatus del GE 99000 parpadeard répidamente.
Cuando haya terminado, la luz indicadora parpadeard de forma
lenta y continua.

Usando el GE 99000 con su computadora en Modo de
transmision de Datos

Antes de usar: Antes de conectar el GE 99000 en MODO DE
TRANSMISION DE DATOS, instale el software incluido.



1
a.

Configuracion

Asegurese de que la computadora cuente con el sistema
operativo Windows® 98SE/ME/2K/ XP o ediciones posteriores y
de que todas las actualizaciones de Windows® estén instaladas.

. Coloque el CD BlueSoleil" en el lector de CD-ROM.

El software empezard a correr automdticamente.

. Sino es asi, utilice la ventana del explorador y abra el folder del

CD-ROM. Ubique del archivo de instalacion (Setup) y haga
doble clic.

. Elija el lenguaje que quiera y siga las instrucciones para

completar la instalacion. Durante el proceso de instalacion,

el software le puede preguntar si desea continuar. Elija
‘continuar’. Debido a diferentes perfiles y configuraciones de su
computadora, puede recibir varios mensajes como éste.

Siesto le preocupa, puede detener el proceso y revisar el manual
completo que viene en el CD-ROM o visitar la pdgina web de
BlueSoleil en www.bluesoleil.com.

. Una vez que la instalacién haya terminado, tendrd que reiniciar

su computadora.

Las instrucciones completas sobre como usar el software estdn en el CD
incluido o puede usar los ments de ayuda en el programa BlueSoleil™.

2.
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Empezando a usar el
software BlueSoleil™
Coloque el interruptor del GE
99000 en modo DATA
Conéctelo a un puerto USB de
la computadora. Espere unos
minutos a que aparezca la
ventana para configurar el
adaptador USB. Para empezar
a usar el software, haga doble
clic en elicono de BlueSoleil".

. Asigne un nombre a su ubicacién o computadora.



c. Siquiere cambiar de
nombre, haga clicen el
mend “My Bluetooth®"y
seleccione “Device
Properties” (Propiedades
del dispositivo). Ingrese
un nombre exclusivo en
el campo “Device Name
(Nombre del dispositivo).

d. Laesferanaranjaen
medio de la pantalla represento eI odoptodor de modo dual de
su propio GE 99000. Para empezar a buscar otros aparatos
Bluetooth®, haga clic en la esfera. También puede hacer clic en
“View">"Refresh Devices” ("Ver">"Actualizar Dispositivos’) para
encontrar otros dispositivos.

"

Servicios disponibles

1) Encienda los dispositivos Bluetooth® con los que quiere
sincronizar los datos.

Para que BlueSoleil” reconozca los aparatos, haga clicen la
esfera naranja del centro.

Después de que el receptor haya sido reconocido, la direccién
que aparece bajo el icono es la direccion Bluetooth® del
dispositivo. Si necesita encontrar otro dispositivo Bluetooth®,
repita el paso 2, o presione la tecla F5 para “Actualizar los
Servicios” nuevamente y el nombre cambiard al nombre del
dispositivo.

Haga clic izquierdo o doble clic en el icono del dispositivo para
confirmar si hay algdn servicio disponible. Sino es asi, tendrd
que actualizarlo hasta que alguno de los iconos de servicios
(audifonos o A/V) se pongan amarillos. Los iconos amarillos
indican los servicios que estdn disponibles. Elija uno de los
servicios para que la conexion se establezca. Cuando la
conexion esté establecida, habrd una linea que une el
dispositivo a la esfera naranja del centro.
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Para escuchar masica

5) Para escuchar misica, elija “Bluetooth® AV Service” (Servicio

Bluetooth® de A/V) o haga clic en el segundo icono de la derecha.

Cuando la conexion se establezca, podrd ver un enlace entre el

receptory el adaptador GE 99000.

Después de configurar BlueSoleil" y escoger los dispositivos,

para escuchar musica tendrd que abrir Windows® Media Player,

Music Match o cualquier otro reproductor multimedia. En breve,

escuchard musica del receptor. Tome en cuenta que primero

tiene que abrir BlueSoleil™ y luego abrir el reproductor
multimedia de su computadora.

Sino puede escuchar la musica, revise que haya seleccionado el

dispositivo y el servicio, y que estén conectados. El icono de

BlueSoleil" se debe poner verde para indicar que estd conectado

y estd en uso.

8) Para desconectar el dispositivo, haga clic derecho en el icono
del dispositivo y elija “Disconnect”>"Bluetooth® AV Service”
(Desconectar>Servicio Bluetooth® de A/V).

9) Para salir del programa, haga clic en “File” >"Exit” (Archivo>Salir).

Solo se puede usar o conectar al software BlueSoleil, un dispositivo
ala vez. Los controles avanzados de reproduccion (reproducir,
pausa, cancién anterior, siguiente cancion) no funcionaran
necesariamente con software de terceros. Ejemplo: Los controles
funcionan perfectamente con las versiones actuales de Windows
Medlia Player pero no con MusicMatch. Esto es sélo en modo de
transmision de datos; cuando el adaptador estd en modo A/V,
todos los controles funcionaran adecuadamente.
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Para usar Telefonia por Internet - Configuracion / Pre-requisito
Confirme que su computadora tiene instalado el software de



Telefonia por Internet. Aseglrese de que el receptor Bluetooth®
no esté conectado a otros dispositivos Bluetooth®.

Introduccion basica

1) Para iniciar el software, haga clic en el icono de BlueSolei
2) Encienda el receptor Bluetooth®.

3) Con BlueSoleil haga una bisqueda para identificar el
receptor Bluetooth®.

Haga clic derecho en el icono del dispositivo y elija “Refresh
Services” (Actualizar Servicios). También puede hacer clic en
“View">"Refresh Devices” (Ver">"Actualizar Dispositivos”).

Haga clic derecho en el icono del dispositivo. Elija “Connect”>
"Bluetooth® Headset Service"(Conectar>Servicio de Audifono
Bluetooth® o haga clic en el primer icono de la derecha.

*Nota: Pasados 25 sequndos sin ninguna respuesta, dejard de timbrar y el
sistema se desconectard automdticamente. Para continuar, repita el proceso
de configuracién. Cuando esté usando el servicio de Telefonia por Internet,
no podré conectar el teléfono habilitado con Bluetooth®.

™
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Para conectarse con el MSN®
1) Inicie el Messenger MSN®. Elija “Audio /

Video Tuning Wizard” (Asistente para ajuste =

de Audio/Video). i'”-v.-: e —
2) Configure “Microphone” (Micréfono) y e e

“Speaker” (Parlante) como “Bluetooth® Audio” 1_5_1-:"—

(Audio Bluetooth®). P !
3) Continde con el proceso y termine con la Py 3

configuracion. e 7y,
4) Empiece a usar el Messenger con el

receptor Bluetooth®.

Para conectarse con SKYPE®
Inicie SKYPE®. Para usar el receptor Bluetooth® no tiene que

modificar la configuracion.
Nota: Si atin asi no puede usar el receptor, vaya a “File”>"Options”">"Hand/Headsets”
(Archivo>Opciones>Audifonos). Deje la configuracién tal como se muestra.
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Para conectarse
con SKYPE®

Para usar servicios de
teléfonos

Consulte el manual de su
teléfono para activary
conectar el servicio
Bluetooth® de su celular.

Sincronizacion con teléfonos

1) Encuentre el teléfono habilitado con Bluetooth®.

2) Use BlueSoleil" para encontrarlo.

3) Haga clic derecho en el icono del teléfono y elija
“Refresh Services” (Actualizar Servicios). También puede hacer
clic en “View">"Refresh Devices” (“Ver">"Actualizar Dispositivos”).

4) Los servicios disponibles tendran iconos amarillos.

5) Escoja el servicio que quiera usar.

6) Antes de escoger algin servicio, primero tendrd que sincronizar
el teléfono. Deberd ingresar la clave en el teléfono.
Generalmente es “0000". Luego en la columna de la
clave en BlueSoleil"™, ingrese la misma clave.

Transferencia de archivos

Una vez sincronizado el teléfono, podrd
intercambiar archivos entre el teléfono y
la computadora.

Carga de objetos
Elija la funcion “Object Push” (Carga de Objetos) para
colocar la informacion de la PC al teléfono.




Sincronizacion de informacion
Utilice la funcion “Information Synchronization”

(Sincronizacién de Informacion) para sincronizar los archivos
con su teléfono. De esta forma, los archivos en su teléfonoy la
informacion en Microsoft® Outlook estardn sincronizados.

Solucion de problemas

¢Por que no puedo establecer una conexion con el receptor?

1) Asegurese de que la bateria del receptor no esté baja.

2) Asegurese de que el receptor esté encendido y de que el
adaptador GE 99000 esté conectado al puerto USB.

3) Verifique que el receptor esté dentro del rango de alcance,
a menos de 100 metros del adaptador.

4) Revise si hay otro dispositivo Bluetooth® conectado al receptor.

5] Apague el receptor y desconecte el adaptador GE 99000. Encienda
el receptor y conecte el adaptador GE 99000; intente conectar el
receptor nuevamente.

La musica no se puede transmitir.

En algunos casos serd necesario que configure su computadora

manualmente para poder reproducir la mdsica a través del

dispositivo Bluetooth®. Para hacer esto, siga los siguientes pasos:

1) Conecte el GE 99000 a un puerto USB disponible.

2) Espere para iniciar la configuracion.

3) Vaya a START (INICIO]) > Control Panel (Panel de Control).

4) Seleccione Sounds and Audio Devices (Sonido y Dispositivos de Audio).

5) Seleccione la Pestana de Audio.

6/ Use el men(i desplegable en sound playback (reproduccion de
sonido) para configurar el Audio Adapter [Adaptador de Audio)
como el dispositivo predefinido.

7) Elija Apply (Aplicarly OK.

8) Reinicie el reproductor multimedia, escoja una cancion y empiece
a reproducir (Play).

Para ayuda técnica, consulte el manual que estd en el cd incluido

o visite www.bluesoleil.com.
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Especificaciones

Estandar, Clase de poder

Compatible con Bluetooth 1.2, Clase 1

Interfaz

USBv1.1(Tipo A)

Perfil de Bluetooth® - Modo AV

Perfil A2DP, AVRCP

Modo HCI

Acceso Genérico (GAP)

Aplicacion de Reconocimiento de Servicios (SDAP)

Puerto serie (SPP)

Red de Dial-Up (DUN)

FAX

Transferencia de archivos (FTP)

Acceso a LAN (LAP)

Sincronizacion (SYNC)

Carga de objetos (OPP)

Intercambio Genérico de Objetos (GEOP)

Audifono (HSP)

Recambio del Cable de Impresion (HCRP)

Dispositivo de Interfaz Humana (HID)

Sensibilidad del Receptor

<0.1% BER at -86 dBm

Salida/Poder

-6dBm a 17dBm

Distancia de funcionamiento

Hasta 100 metros/300 pies en espacios abiertos.*

Frecuencia de banda

2.400~2.4835GHz banda ISM sin licencia

Modulacion GFSK (Modulacién por desplazamiento de
frecuencia gausiana)

Espectro FHSS (Espectro disperso por salto de frecuencia)

Voltaje operativo Alimentacion directa del puerto USB

Temperatura de
funcionamiento

-10°C~+55°C

*Nota: £l mdximo rango de operacién depende del modelo del teléfono
sincronizado, energia de la bateria y factores ambientales.
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DESCARGO DE REPONSABILIDAD

Si bien se ha realizado todo esfuerzo para asegurar que la informacion de este
manual sea precisay completa, no se aceptard ninguna responsabilidad por
errores u omisiones hechas. El fabricante se reserva el derecho de hacer, sin
previo aviso, cambios y mejoras a las especificaciones y funciones del equipo
fisico 0 logico de los productos descritos en este documento. Se prohibe la
reproduccion, transferencia, distribucion o almacenamiento de parte o de todos
los contenidos de este documento, en cualquier forma, sin el consentimiento del
fabricante. Todas las marcas registradas estdan reconocidas.

Garantia limitada de un afio

La Compania Jasco Products garantiza por un periodo de un afio desde

la fecha original de la compra, que este producto no presenta ningin
defecto de fabrica. Esta garantia estd limitada sélo a la reparacion o
reemplazo del producto y no se extiende al dafio resultante o incidental

de otros productos que se han sido usados con esta unidad. Esta garantia
remplaza a cualquier otra garantia expresa o implicita. Algunos estados no
reconocen limites de tiempo en las garantias implicitas y tampoco permiten
la exclusion o limitacion de danos incidentales o resultantes; por lo tanto,
las limitaciones mencionadas pueden no ser aplicables en su caso. Esta
garantia le proporciona derechos especificos; pero dependiendo del estado,
también puede tener otros derechos. Si esta unidad presenta algin defecto
dentro del periodo de garantia, devuélvala junto con el costo del envio y la
prueba de compra, a: Jasco Products Company, 10 E. Memorial Road,
Oklahoma City, OK 73114

La marcay logos Bluetooth® so propiedad de Bluetooth® SIG, Inc.y
cualquier uso de esas marcas por parte de Thomson Inc. estd bajo licencia.
Las otras marcas registradas y nombres comerciales son de sus respectivos
duefios.

©2006 JASCO Products
Hecho en China
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